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1 Introduction

1.1 Objective

This is the official guide for Coupa Adapter for SAP Integration Suite. This guide covers all relevant
information for integration developers to start working with the Coupa adapter. Read this guide carefully
before using the Adapter.

1.2 Coding Samples

Any software coding and/or code lines/strings ("Code") included in this documentation are only examples
and are not intended to be used in a productive system environment. The Code is only intended to better

explain and visualize the syntax and phrasing rules of certain coding. The correctness and completeness of
the Code given herein are not guaranteed.

1.3 Internet Hyperlinks

The documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint
about where to find related information. The availability and the correctness of this related information or
the ability of this information to serve a particular purpose are not warranted.

1.4 Overview

Coupa is a unified cloud-based business spend management platform. Its module-based cloud platform
makes it easy to cover, extend your financial management needs, and provides an overview of expenditures
from everywhere. It efficiently captures, matches, and processes incoming expenses, aiming for a high
accuracy rate (90%) in the initial matching step. This helps streamline expense management and reduces the
need for manual adjustments.

The Coupa adapter helps you exchange data between Coupa and other systems. Some business scenarios
that the adapter can be used for are as follows:

e Synchronizing master data.
e Synchronizing transactional data.
e Orchestrating the integration to realize a “Procure to Pay” process.



1.5 Features

The Coupa adapter has the following key features:

e Secure authentication with OAuth 2.0: Connecting Coupa with other applications is securely
achieved by employing OAuth 2.0 authentication process. Every REST call between Coupa and
SAP Integration Suite is secured by specific authorization flows.

e Supports all Coupa operations: Our Adapter has support for all Coupa operations including
Create, Get, Modify, Query, and Update Resource operations.

e Auto Pagination: You can query efficiently with our integrated pagination support. Coupa adapter
supports querying of all records of a resource using Auto Pagination.

e Dynamic configuration with headers and properties: Assigning dynamic values to different
properties allows enhanced flexibility to your integration flows. You can also refer to dynamic
parameters using SAP Integration Suite exchange headers and properties.

e Support for XML & JSON: Coupa Adapter extends support for multiple payload formats. XML and
JSON are fully incorporated throughout the adapter.

e Coupa Eclipse plug-in: The Eclipse plug-in helps to generate all necessary up-to-date message
XSDs for specific resources and the custom objects in the Coupa.

e Full integration support for Custom Objects and Fields: In addition to support for every standard
Coupa resource, the adapter also integrates with all custom objects in Coupa.



2 Installation and Configuration

This section details the file(s) available as part of the installation package and lists the necessary prerequisites
needed to install and configure the Coupa adapter.

6 The Coupa adapter is available as part of your SAP Integration Suite license.

The Coupa adapter also comes with a plug-in to generate source and target XSDs. To use this plug-in, you
need an Eclipse installation. For more information, see Coupa Plug-in Installation.

Before you begin, you must download the Coupa plugin bundle from the SAP Marketplace that contains the
file(s) listed in the following section.

2.1 Package Details

The Coupa plug-in installation package contains the following file:

File Type |File Name Description

Plug-in File | Coupa-plug-in_<version>jar | This file is used to install the plug-in.

2.2 Prerequisites

Before you begin, you must:
e Download and install the Coupa plugin bundle from the SAP Marketplace.
e Download and install the SAP-recommended version of Eclipse. Currently, Eclipse Oxygen is

recommended.

For more information about the latest SAP recommendations see, SAP Development Tools.

2.3 Adapter Installation on Cloud Foundry

Before the Coupa adapter can be used in the Cloud Foundry environment, it must be deployed to the SAP
Integration Suite.

2.3.1 Prerequisite

To deploy the Coupa adapter, you must have access to “Coupa Adapter for SAP Integration Suite” as part of
your SAP Integration Suite license.


https://tools.hana.ondemand.com/#cloudintegration

2.3.2 Procedure

The following installation procedures are compatible with Apache Camel 2, Apache Camel 3,
and Edge Integration Cell (EIC) platform.

2.3.2.1 Coupa Adapter Installation by Creating a New Integration Flow

The Coupa adapter is available for selection in the receiver adapter list and can be deployed in the Design
tab directly as you use it in an Integration flow.

Purpose

To install an adapter for use in your Integration flow.
Procedure

Go to Design workspace and select the integration package where you want to create a new Integration
flow.

1. Click Edit to make the package editable.

2. Go to the Artifacts tab. Click Add and select Integration Flow.

3. Enter the Name and ID for your flow. Additionally, select Runtime Profile from the drop-down and
choose Sender and Receiver systems from the list O'. Finally, click Add to create the integration
flow.

4. Go to the newly created integration flow and click Edit to make it editable.

5. Inthe integration flow, click End to add a Connector ' between the End and the Receiver Box.

A drop-down with the available adapters appears. The Coupa adapter should show up in the list.

6. Select the Coupa adapter from the list. The adapter is now imported which triggers an adapter

deployment. Once the Coupa Adapter is deployed, a success message is displayed.

After the above steps are done, the Coupa Adapter is successfully deployed in your Design workspace of the
SAP Integration Suite tenant.

2.3.2.2 Coupa Adapter Installation without Creating a New Integration
Flow

0 The following procedure describes how the Coupa adapter is migrated from the Discover
workspace to the Design workspace of the SAP Integration tenant.

This method is useful for scenarios where integration flow packages are migrated from development to a
higher environment such as Production.



The Coupa adapter can be imported into the Design workspace without creating an integration flow. Use
the Transport Management Service (TMS) to import/transport the Coupa adapter to a higher
environment. Alternatively, if the TMS is not available in the landscape, the adapter package can be
imported into the Design workspace by copying it from the Discover workspace.

Purpose

To import the Coupa adapter to Design workspace by copying the integration package from Discover
workspace.

Procedure

1.  Go to Discover workspace.

2. In the search box, search for Coupa adapter for SAP Integration Suite package.
3. Select the package and click Copy.

This copies the package from the Discover workspace to Design workspace.

4. Go to Design workspace and select the copied Coupa adapter for SAP Integration Suite package.
5. Inthe Actions tab of the selected package, click Deploy.

This completes the adapter deployment to Design workspace.

2.3.3 Monitor the Deployment Status

After the adapter deployment is complete, you can check the status in the Monitor section.
Purpose

To check the status of the deployed adapter.

Procedure

1. Under the Monitor tab, click Integrations and APls. This opens the Overview page.

2. Onthe Overview page, go to Manage Integration Content section and click All. This opens
Integration Content page with a list of all the deployed adapters.

3. Here, you can check and confirm the deployment status of your adapter.

ntegration Content (627)

Coupa

Status Details  Artitact Detail

Artifact Details



2.4 Coupa Plug-in Installation

Prerequisites

Before you begin, you must download the Coupa plugin bundle from the SAP Marketplace. For more
information, see Coupa Installation and Configuration.

Purpose
To install the Coupa plug-in.

Procedure

1. Download and install Eclipse Oxygen 3a from Eclipse Oxygen.

2. After Eclipse installation, go to your Eclipse installation folder (Example: C:\Program Files
(x86) \oxygen\eclipse) and open the Plug-in folder.

3. Copy the Coupa Plug-in JAR file (that you downloaded from the SAP Marketplace) into the Plug-in
folder.

4. Open Eclipse Oxygen and go to Windows > Perspective > Open Perspective > Other.

File Edit Navigate Search Project Run Window Help

Hmid @~iBiw|BDE M= New Window ’*Q"%'V‘:VQv‘&'va'a':{ . . .
Editor >
&5 Project Explorer 2 AT N ‘
Show View >
Perspective > Open Perspective > 3 Debug
1
Navigation > Customize Perspective... (Y 3

+ JPA
5 Resource
@ Web

5 Save Perspective As..
Reset Perspective..
Close Perspective
Close All Perspectives

Web Browser
Preferences

Other...

5. Select Coupa Adapter Workbench and click Open.

2 Open Perspective m] X

AJ Adapter Development
{esa CVS Repository Exploring
15 Debug

ar) Git

%2 Integration Operations
&/ Java (default)

¢ Java Browsing

EJJava Type Hierarchy
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6. Go to Window > Preferences > Coupa Preferences.


https://www.eclipse.org/downloads/packages/release/oxygen/3a

Window Help
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Editor b
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Show View >
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Navigation >

Web Browser >
Preferences

7. Inthe Coupa Preferences widget, fill in the Coupa Settings details. You can retrieve these details
from your Coupa tenant.

To retrieve Settings details and respective login credentials to set up a Coupa connection
to the specific tenant via an OAuth 2.0 app, see Coupa Adapter Guide.

8. Verify the Settings details and the credentials by clicking the Test Connection tab.
9. Upon successful test, click Apply and Close to complete the installation.

After you hit Apply and Close, the plugin takes a while to set up based on your saved
preferences. The required swagger files are being retrieved from the APl documentation
in the background. Consequently, the loading time varies depending on your machine.

8] Preferences [} X
coupa @ Coupa Preferences v o
Coupa Preferences
@ . Coupa Settings

Authentication Type OAuth Client Credentials v

Address hitps/y koupacloud.com

Identifier

Secret

Scopes travel_booking.common.read travel_booling.search.wrnite travel_booking team.read travel_bocking.team write ~
travel_bookingtrip.read travel_booking trip.write travel_bocking.user.read travel_booking.user.write
treasury.cash_management delete treasury.cash_management.read treasury.cash_management.write v

[ Save preferences in secure store

o Coupa login successful

Test connection
Restore Defaults Apply
'J C Apply and Close Cancel

Now you are set up to use your Coupa adapter and Coupa plug-in.



3 Getting Started: Coupa Adapter

Before you start using the adapter, you can get to know the underlying Architecture for the adapter and
Authentication mechanism for Coupa. Finally, a list of all the Supported Operations have been provided.
Comprehensive details of the operations can be found in the Coupa Adapter Operations.

3.1 Architecture Overview

The Coupa adapter can be employed as a receiver adapter. In such a scenario where the Coupa Adapter is
used as a receiver adapter, SAP Integration Suite acts as the initiator of the calls.

The Coupa adapter supports various operations such as Create Resource, Get Resource by ID, Modify
Resource, Query Resource, and Update Resource. To know more about the different operations supported,

see Supported Operations.

The figure below demonstrates the request-reply step using a Coupa adapter and gives a high-level
representation of how the adapter works.

Integration Process

SAPECC a 20 6 3.0 saracc

» Source Mapping Target * Request- Reply »| Source Mapping Target .

Start End

a 2.Adapter

Coupa

The Coupa adapter works as a Request-Reply step in the integration process, responsible for connecting and
interacting with Coupa to invoke its operations.

The Eclipse Plug-in, which is included in the adapter package, is used to help the user to generate XSDs of
the different entities or resources that are available in your Coupa tenant.

The XSDs generated by the Eclipse Plug-in can be imported in an Integration Flow and used in mappings.



e Forinstance, it can be added before the Request-Reply Step in the above mapping. This way, you
can create the correct XML request message to create or modify a resource in Coupa (see the
Mapping Step on the left side of the Request-Reply Step).

e Similarly, you can use the XSDs to create a mapping to handle the response message returned by
Coupa (see the Mapping Step on the right side of the Request-Reply Step).

Furthermore, the Eclipse Plug-in XSD Generator helps you generate up to date XSDs for your Coupa
resources for all the different operations like create, get, and modify.

For more details about the Coupa plug-in and XSD Generator configuration, see Coupa Plug-in Installation.

The figure below portrays the stages of Coupa adapter usage in the SAP Integration Suite flow, including
Coupa Plug-in generated request XSD and response XSD.

Integration Process
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3.2 Authentication

The Coupa adapter supports only OAuth 2.0 authentication. The adapter uses common security artifacts
stored in SAP Integration Suite. You must use Secure Parameter and User Credentials to safely store OAuth
tokens, user-password combinations, and secrets. These security artifacts can then be accessed in the
adapter using aliases.

The Coupa adapter uses the OAuth 2.0 Autonomous Client type. The adapter requires OAuth Client
Credentials with Client Identifier, Client Secret, and Scope values.

These app credentials consist of a client id and client secret. The Coupa adapter can make different requests
to Coupa resources using the access token that is returned from the authorization server.



The diagram below explains the process used in the background to connect to Coupa.
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3.3 Supported Operations

The operations supported by the Coupa adapter are listed below:

e Create Resource

e Get Resource by ID
e Modify Resource

e Query Resource

e Update Resource

Create Resource is selected by default and allows you to integrate with Coupa using XML or JSON
formats. The integration is carried out securely by utilizing the OAuth protocol for authenticating your REST
calls. All the operations enable the user to access the full data resources of Coupa and execute

CRUD operations.



4 Coupa Adapter Configuration

This section describes the parameters to be configured for your Coupa adapter. You need to configure the
Connection and Processing tabs. A description and example usage for every field has been added.

4.1 Receiver Adapter

In this section, you will learn how to configure the Coupa receiver adapter. On selecting the Coupa adapter
from the list of adapters, you must configure the General, Connection, and Processing tabs.

411 General

The General tab provides an overview of basic adapter information including Channel and Adapter details.

Name: | Coupa

CHANNEL DETAILS ADAPTER DETAILS

Direction:  peoiver Adapter Type:  coupg

" Receiver Transport Protocol: oo

Description: et Message Protocal:  pe o

Field Description

Name Specify Name for your Coupa Adapter.

Description | Specify the required description.

4.1.2 Connection Tab

The Connection tab contains connection and authentication parameters for Coupa. The adapter only
supports OAuth 2.0 authentication.

A sample configuration for Connection Tab is shown in the image below.

Externalize @ B 55



Coupa

General

Connection

Processing

OAuth Client Credentials v

The connection tab contains the following fields:

Field Description
Specify the recipient's endpoint URL, this is Coupa tenant’s URL of the organization.
Address
Example: https://<your coupa instance>.coupacloud.com
Specify the name of the User Credentials artifact configured or saved in the SAP Security
OAuth Material. It contains the Coupa OAuth key and client secret pair.
Credential
Name This property enables the system to fetch the security token from the
Keystore for authentication.
Specify the permissions configured in Coupa. You can enter multiple scope values separated
by a space.
Scopes
Example: core.accounting.read core.account.write
core.budgeting.write
. Specify the connection timeout in milliseconds. You can configure the maximum waiting
Connection | .. . .
. .| time for the connection to be established between SAP and Coupa.
Time Out (in
ms
) Example: 3000
Response Specify the response timeout in milliseconds. You can configure the maximum waiting time
. P .| for SAP until a response is received from Coupa.
Timeout (in
ms
) Example: 3000

For more information on how to retrieve details of the Coupa OAuth key-client secret pair, see References.

4.1.3 Processing Tab

The Processing tab contains all the operational configurations for the Coupa adapter.

A sample configuration for the operation Create Resource (Accounts) is shown in the image below.




The processing tab contains the following fields:

Field Description
Specify the type of action you want to run in Coupa. To access and exchange data with
. Coupa, you can choose one of the available operations.
Operation
For more information, see Supported Operations.
Select the name of the Coupa resource to perform the APl operation. It can be any of the
Coupa defined resources like Reference Data, Transactional, Shared resources, or user
defined custom object resources. This is an editable dropdown field; you can manually add
Resource any other resource that are not listed in the dropdown.
0 Since the dropdown is editable, ensure you do not leave the operation field blank.
Specify the resource key and value in case resource path includes parameters.
ResoUrce Syntax: If Account/ : id is the resource, Name should be specified with id, and Value
should be specified with <account id> value the corresponding value pair.
Parameters -
Example: Name: id, Value: 6351
Return Specify the set of fields to be passed in the response payload. The format of the “return
. objects” must be JSON.
Object
Fields , ,
Example: ["firstname", "lastname", {"roles": ["id", "name"] }]
Specify the format of the request message to be sent to and the response to be returned
Payload from Coupa.
Format
Acceptable Values: Application/JSON, Application/XML




Field

Description

Create Resource operation allows working with attachments. After selecting a resource
including attachments such as invoices/:invoice_id/attachment, additional fields appear as
described below. For more information, see Create Resource using Attachments.

Data from | Select this checkbox to specify whether the attachment object should be obtained from an
Attachment | attachment of the Message Exchange in SAP Cl or the from the Body in SAP Cl.

When selecting data from attachment, specify the name of the attachment on the exchange

in SAP Cl to retrieve the file.
Attachment
name Example: Filename.zip, ${property.filename}.zip

This field appears when you check Data from Attachment checkbox.
File Name | Specify the file name to be uploaded to Coupa.

The type of attachment for Coupa.
Type

Default: file.

Specify the key and value in case attachment includes parameters. You can add Property
Attachment . . . . , ,

. Name and Property Value pairs for various fields like file-url, linked-to,

Properties ,

intent, text, url.

Query Resource operation allows querying of any Coupa Resource. After selecting this
operation additional fields appear that help you to customize your query requests. For more
information, see Query Resource.

Specify the number of records to be fetched with a maximum of 50.

Example: 20
Limit
When auto pagination is enabled, the Limit value does not work as all the
records will be queried or up to the pre-defined limit value of 100.
Specify the offset value to be used.
Offset
Example: 20
Auto Select the checkbox to enable retrieval of all records in case query result has more than one

Pagination

page of records.




Field Description
Specify the querying parameters to retrieve the records. Name, operator, and value can be
added for each filtering parameter.
Example:
Query Filter
Parameter |Name Contains Created date
Operator Contains Greater Than
Value Contains 2202-01-01
Order by Specify the field or resource property to perform the sorting of the queried records.
Field
Example: Name
Sorting Specify the sorting order of the records. It can be either Ascending or Descending.
Direction

Acceptable Values: Ascending, Descending




5 Coupa Adapter Operations

This section contains a comprehensive description of all the operations supported by the Coupa adapter.

5.1 Create Resource

This operation allows creation of any new record of a specified Coupa resource. The request payload should
be provided with all the required property and field values of the resource to be created in the request. The
response body will contain the unique identifier (ID) of the created record if the call is successful and returns
all the Coupa elements of the resource.

Resource Parameters: o

O name Value

The configuration details are as follows:

Field Description

Operation Specify the operation to be performed: Create Resource.

Specify any of the available resource types in Coupa - Reference Data resource,
Transactional resource, Shared Resource or Custom object resource.

Resource

Example: accounts

. Specify only limited elements to be returned in the response payload.

Return Object pecify only P pay
Fields .

Example: ["id", "lastname"]

Specify the request and response payload format.
Payload pectly 9 b pay
Format

Acceptable Values: Application/JSON, Application/XML

5.1.1 Create Resource using Attachments

The Create Resource operation also allows you to work with attachments. After selecting a resource that
includes attachments such as invoices/:invoice id/attachment, additional options appear in the
Processing tab.



Attachment Properties:

Property Value

The configuration details are as follows:

Properties

Field Description

Operation | Specify the operation to be performed: Create Resource.
Specify any of the available resources in Coupa which includes an attachment.

Resource
Example: invoices/:invoice id/attachments
Select this checkbox if the attachment object must be obtained from an attachment of the
M Exch in SAP CI.

Data from essage Exchange in

Attachment . D . .
Leave the checkbox unchecked if the attachment object is being retrieved from the Body in
SAP Cl.
When selecting data from attachment, specify the name of the attachment on the exchange
in SAP Cl to retrieve the file.

Attach t . . .

Narance men This value can be read dynamically using an exchange header or property.

${property.filename}.zip.

Example: Filename.zip, ${property.filename}.zip

File Name | Specify the file name to be uploaded to Coupa.
The type of attachment for Coupa. The dropdown allows selection from multiple options
including file, text, and url.

Type
Default value: file

Attachment | You can add Property Name and Property Value pairs for various fields like file-url,

linked-to, intent, text, andurl.




Field Description

Payload Specify the request and response payload format.

Format

Acceptable Values: Application/JSON, Application/XML

The below table elaborates the available option for Attachment Properties.

Property Name | Property Value
A label that can be added to the attachment, that is visible in Coupa.

Intent
Example: Supplier

file-url URL to the attached file to be sent to Coupa with the attachment.

linked-to Link to a specific feature to be sent to Coupa with the attachment.

Text Text element to be sent to Coupa with the attachment in case Type was selected as
text.

url URL element to be sent to Coupa with the attachment, in this case Type was selected
asurl.

5.2 Get Resource By ID

The operation allows retrieval of a specified record of a Coupa Resource by ID. The ID of the resource can be
provided in the resource parameter or can be passed as a dynamic header value. The response body returns
all the Coupa elements of the specified target resource.

astname”]



The configuration details are as follows:

Field Description

Operation Specify the operation to be performed: Get Resource by ID.

Specify the target resource to be fetched.
Resource
Example: accounts/:id

Specify the resource id or any other element as key and value pair.
Resource Parameters
Example: Name: id, Value: 1653

Specify only limited elements to be returned in the response payload.
Return Object Fields
Example: ["id", "lastname", "email"]

Specify request and response payload format.
Payload Format

Acceptable Values: Application/JSON, Application/XML

5.3 Modify Resource

The operation allows modification of any specific record of a Coupa Resource by passing the ID. The ID of
the resource can be provided in the resource parameter or can be passed as dynamic header value.

This operation uses Patch API of Coupa. After updating the record in Coupa, the response body returns all
the Coupa elements of the specified resources that are being updated.

HEADER SETTINGS
Outbound Headers: a
O Name Vaiue



The configuration details are as follows:

Field Description

Operation Specify the operation to be performed: Modify Resource.

Specify the target resource to be modified.
Resource
Example: accounts/:id

Specify resource id or any other element as key and value pair.
Resource Parameter
Example: Name: id, Value: 1653

Specify required elements to be returned in the response payload.
Return Object Fields
Example: ["id", "status", "website"]

Specify request and response payload format. It can be either XML or JSON.
Payload Format
Acceptable Values: Application/JSON, Application/XML

5.4 Query Resource

The operation allows querying of any Coupa Resource. You can customize your query requests by
configuring Query Filter Parameters, Order by Field elements, and Sorting Direction (Ascending or
Descending).

The response body will return all the Coupa elements of the specified resource that are being queried, you
can also Limit the maximum number of records to be fetched, set the Offset for the fetching records, and

enable Auto Pagination feature for bulk records retrieval.

The configuration details are as follows:



O Name Operator Value

O | Name Contains v

O  operator Con v

O | Value on v

&l Ce

Ordier By Field: [ c |
O Field

O | Name

A description of the fields is given in the table below.

Pagination

Field Description
Operation | Specify the operation to be performed Query Resource.
Specify the target resource to be queried.
Resource
Example: accounts
Specify resource id or any other element as key and value pair.
Resource pedtly y 4 P
P t .
arameters Example: Name: id, Value: 6351
Return Specify required elements to be returned in the response payload.
Object
Fields Example: ["id", "name", "email"]
Payload Specify request and response payload format. It can be either XML or JSON.
format ) )
Example: application/XML
Specify the limit to query records with maximum of 50 records.
Example: 20
Limit
When auto pagination is enabled, the Limit value does not work as all the
records will be queried or up to the pre-defined limit value of 100.
Specify the offset value for the number of records to be skipped while querying.
Offset
Example: 20
Auto Select the checkbox to enable retrieval of all records in case query result has more than one

page of records.




Field Description

Specify the querying parameters to retrieve the records. Name, Operator, and Value can be
added for each filtering parameter.

Query Filter Example:

Parameter
Name Contains Created date
Operator Contains Greater Than
Value Contains 2202-01-01
Order by Specify the field or resource property to perform the sorting of the queried records.
Field
Example: Name
Specifies the sorting order of the records. It can be either Ascending or Descending.
Sorting . .
L Acceptable Values: Ascending, Descending
Direction

Default: Descending

5.5 Update Resource

This operation allows update of any specific record of a Coupa Resource by passing the ID of the resource.
You can provide the ID in the Resource parameter or pass it as a dynamic header value. This operation uses
PUT API of Coupa. After updating the record in Coupa, the response body returns all the Coupa elements of
the specified resource.

(o

HEADER SETTINGS

Sy o
e e



The configuration details are as follows:

Field Description

Operation Specify the operation to be performed: Update Resource.
Specify the target resource to be updated.

Resource

Example: supplier/:id

Resource Parameters

Specify resource id or any other element as key and value pair.

Example: Name: id, Value: 1536

Return Object Fields

Specify required elements to be returned in the response payload.

Example: ["id", "status", "website"]

Payload Format

Specify request and response payload format. It can be either XML or JSON.

Example: application/XML




6 Payload and Dynamic Configuration

The Coupa adapter supports different message formats. It also supports dynamic configuration of its
properties using both the header and property features of the SAP Integration Suite exchange. Both header
and property features of the exchange can be used in Coupa adapter properties.

6.1 Message Payloads

Many operations require a Message as input to be sent to Coupa. For example, to create an object in Coupa
using the Create Resource operation, you need to specify the fields and values in the message body to be
inserted in Coupa. To achieve this, you first need to specify the Coupa Resource type in the Coupa adapter.

An example payload to create an Address is shown in the image below:

<?xml version="1.0" encoding="UTF-8"?2>
<address>
<name>Address Name</name>
<city>San Mateo</city>
<postal-code>989048</postal-code>
<state>CA</state>
<streetl>2 W 5th Ave</streetl>
<street2>Suite 300</street2>
<country>
<code>US</code>
<name>United States</name>
</country>
</address>

The XSD Generator assists in determining what structure each Coupa adapter operation expects. It generates
the XSDs that you can use in mappings in your integration scenario. Following our example, the XSD will
include elements/properties of the Objects.

Assuming that you are performing a Create Resource operation in Coupa, using the correct request XSD as
the target of the mapping before the request-reply will help you create a valid input message (payload)
towards Coupa.

The XSDs obtained from the Eclipse Plug-in can help to provide a good understanding of the request

message that the various Coupa operations require as well as the response messages that you can receive
from Coupa.

6.2 Basic Dynamic Configuration Example

Purpose

This section illustrates the use of dynamic values in the adapter property. It depicts a simple Get Resource by
ID operation configuration using a dynamic header reference.

Procedure



2.

You need to use a content modifier before the Request-Reply step in your integration flow, and this
content modifier should create a Message Header. The name of the message header is the name to
be referred to in the Coupa adapter. Any name is allowed here. You can achieve the same by using
the properties instead of a header. In this example, we use the Constant type and fill in the Purchase
Order Id as a value.

Content Modifier

The Coupa Receiver adapter (which is linked to the Request-Reply step) needs to refer to this header
by using ${header.name}. To refer to a property, a syntax similar to ${property.name} should be
used.

In our example below, we can refer to the PurchaseOrderId header using the syntax
${header.Accountld}. The Coupa Adapter will automatically replace this reference with the ID
24587.

Coupa


http://property.name/

7 Eclipse Plug-in Configuration

7.1 XSD Generator

The XSD Generator is developed to support mapping operations in integration scenarios. It generates
request and response XSDs for multiple endpoints that are specific for the Coupa instance.

In the image below, the right side of the view contains a request and response tab that will show the
resulting XSD. If all the required fields are not selected, it indicates which fields need to be selected.

You can get an overview of the different XSDs that can be generated.

.....
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Purpose
To generate an XSD.
Procedure

1. Select the desired operation from the Operation dropdown.
2. Select the resource from the Resource dropdown.



3. Select the level in the Level dropdown.
4. Click Save to save the displayed XSD, switch tabs to save the corresponding response/request
and click Copy Text to copy the XSD text to your clipboard.

The below table outlines the Request/Response XSDs generated for Coupa operations specific to a Coupa
object.

Operation Object Specific | Request | Response
Create Resource X X X
Get Resource by ID X X
Modify Resource X X X
Query Resource X X
Update Resource X X X

7.2 Attachment Response XSD's

Response XSD's for attachment related resources contain different operation elements like attachment-file,
attachment-URL and attachment-text. When using these XSDs in the Message Mapping Ul, it requires a
selection of one of these elements to support the attachment type such as file, URL or text based on what
has been configured in the adapter.

Resources for which this applies include the resources with attachment in the name.

Example: contracts/:contract id/attachments.



8 Support

8.1 Traces

You can monitor, debug, and analyse errors or issues by changing the Log level of your integration flow to
Traces.

You can enable this under Log Configuration under Monitor > Manage Integration Content page in SAP
Integration Suite.

Log Configuration

t: | Trace

The Trace Log level enables the collection of more traces to effectively understand the issues. These traces
can also be used in a ticket.

8.2 Troubleshooting

A few issues that you might encounter and possible solutions for them have been documented below.

Error Error Message Possible Solution
No Artifact [CAMEL][IFLOW][CAUSE]: Cause: This error generally indicates that one
Descriptor com.sap.it.nm.types.NodeManagerException: of the security artifacts used in the
Found [CONTENT][CONTENT_DEPLOY][NoArtifactDecriptorFoundFor | Connection tab in the adapter does
ArtifactName]:No artifact descriptor found for artifactName not exist.
<CoupaOauth>

Ensure that the artifact used in the
connection tab exists as a Security
Material.




Error Error Message Possible Solution

XSD <!-->XSD generation not support for this |When in the Eclipse Plug-In, this
Generation | fesource<—-> error is visible after trying to

not generate a request or response
supported XSD, this means that a part of the
for this structure for the resource that you
resource have selected on the left side is

not currently supported.

9 References

This section provides a step-by-step guide for setting up OAuth authorization for different platforms like
Coupa and SAP Cl, Cloud Platform Coupa Adapter, and Eclipse Coupa Plugin.

9.1 Initializing OAuth setup in Coupa and SAP
Integration Suite

Purpose
To initialize OAuth setup in Coupa and SAP integration Suite.
Procedure

1. Login to the Coupa Tenant using the Coupa URL for the organization.
2. Click All Setup Items.

£ C »
A
Setup
Find it fast! Use the Instant Filter *
(S|

3. Goto Integrations > Oauth2/OpenlD Connect Clients.



Integrations

1P Whiteii Configs
Cauth2/OpeniD Connect Clients

4. Click Create, enter the details as required, select appropriate permissions, and click Save.

Create Client

* Grant type | Client credentials
*Name  Coupa_OauthKey Doc

JWKS URI

List redirect_uris as comma separated (unquoted): http://a.com

*Login Coupa_OQauthKey_Doc
* Contact First Name
* Contact Last Name )
* Contact Email
* Scopes
@ core.accounting.read
core.accounting.write

] core.approval.read

] core.approval.write

5. On saving, you can view the below details. Save this information to connect to Coupa externally.

Name Coupa_OauthKey_Doc
Identifier

Grant Type Chent credentials

Login C

Contact Firstname
Contact Lastname
Contact Email

SBCMEl | sisssssssssnissassersansasssastisssissiassisssssntsansssnsassias

Oide Scopes cor

Active Yes

The Oidc Scopes are the permissions configured in Coupa. You can use these values (separated by a space)
in the Scopes field of the Coupa adapter while configuring the Connection tab.

Furthermore, Identifier and Secret are required in an upcoming section. For more information, see
Configure OAuth in Eclipse Coupa Plugin.



9.2 Initializing OAuth Setup for Coupa Adapter in SAP
Integration Suite

Purpose
To initialize OAuth Setup for Coupa Adapter in SAP Integration Suite.
Procedure

1. Open Monitor tab in SAP Integration Suite.
2. Select Security Material from the Manage Security Material section.

3. Select Add, User Credentials, and enter a Name which is same as the Basic Credential Name that
you have configured in the Coupa adapter Connection tab. In User and Password, insert User with
the Coupa Identifier and Password with the Coupa Security Key. Finally, Click Deploy.

The Coupa OAuth setup is successfully deployed for a secure OAuth connection to Coupa.

6 It is important that the name configured for the OAuth Credential Name in the adapter matches
the names of the deployed artifacts in the SAP secure stores as described in the steps above.

Now that the authentication part is completed, the Coupa adapter can be configured for every specific
Coupa integration scenario.

9.3 Configure OAuth in Coupa Eclipse Plugin

Purpose

To Configure OAuth in Coupa Eclipse Plugin.



Procedure

1. Toinstall Coupa Plugin in Eclipse, see Coupa Plug-in Installation.
2. Once the Plugin is Installed, Open Eclipse > Windows > Preferences. This will open the
Preferences Window.

:-_.] eclipse-WorkSpace_1.0.1125thDec - Eclipse
File Edit Navigate Search Project Run | Window Help

W @"'QQ'U.:‘ New Window -
Editor >
Appearance >
Show View >
Perspective >
Navigation >

3. From the List of Preferences on the left, filter for Coupa.

b @-iBIqQ-iG g~

& Preterences = ”
<oups @ Covpa P —
L Ll Coups Settings

Authentication Type | Outh Client Credentials =

Address

tdentifier

Secret

Scopes

] Save preferences in secure store

Test connection
Restore Defaults Apply
De Apply and Close Cancel

Authentication type dropdown defaults to OAuth Client Credentials.

Enter the Address of the Coupa Tenant.

For Identifier, Secret and Scope values, enter the values generated from the Coupa Tenant.
Click Test Connection.

No vk



8] Preferences

coupa [ Coupa Preferences - -
Coupa Prefer
® s Coupa Settings

Authentication Type  OAuth Client Credentials v

Address https/s ioupacloud.com

Identifier e

Secret Tarsvmsananvernaranns

Scopes travel_booking.common.read travel_booking.search.write travel_booking.team.read travel_booking.team.write -
travel_booking.trip.read travel_booking.trip.wiite travel_booking. read travel_booking user.write
treasury.cash_management.delete treasury.cash_management.read treasury.cash_management.write v

[} save preferences in secure store

« Coupa login successful

Test connection

Restore Defaults Apply

Apply and Close Cancel

®
®

Once the account validation is successful, check the box Save Preferences in the secure store and
click Apply and Close.

After you hit Apply and Close, the plugin takes a while to set up based on your saved
preferences. The required swagger files are being retrieved from the APl documentation in the
background. Consequently, the loading time varies depending on your machine.
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